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GETTING STARTED 

 

Do not EVER use two instances of the robot, or any 

combination of robots with identical magic numbers on a 

same account!!! 

 

For a comprehensive information regarding the recommended, the 

supported currency pairs and for the alternative settings, please visit 

the “Settings” section in your members area. 

 

 

If you decide to trade on more currency pairs at the same time, you may consider reducing the 

risk for each pair (using AutoMM=1-2% for example).  

 
Before installing WallStreet Forex Robot 3.0 on your computer and commencing trading 

on a real account, please read this carefully: it may be crucial for your future profits. 

Trading forex entails risk and each instance of negligence or inattention may 

lead to significant loss! 

1. We strongly recommend that you operate a demo account before trading 

with real money. This will help you become familiar with the way WallStreet Forex 

Robot 3.0 operates before you commit genuine funds to a real money account. 

2. Please be exceptionally careful when determining trading volumes and setting 

automatic risk management parameters! 

3. If you suspect that WallStreet Forex Robot 3.0 might be operating incorrectly, 

please halt operations and contact us immediately! 
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WHAT YOU MUST KNOW BEFORE USING  

WALLSTREET FOREX ROBOT 3.0 

 
 WallStreet Forex Robot 3.0 is compatible with all MetaTrader 4 brokers, as well as 

with brokers using ECN-type order fulfilment. You do not need to change any 

settings. 

 WallStreet Forex Robot 3.0 automatically recognises whether your broker offers 

four or five-digit quotes. You do not need to change any settings. You do not need to 

multiply TakeProfit and StopLoss values by 10 if your broker offers five-digit quotes. 

 We do not recommend that you launch and close your trading terminal too 

often. Ideally, it should work without interruption from market opening on 

Monday to closure on Friday. 

 Maintaining a stable internet connection is of the essence to ensure reliable 

WallStreet Forex Robot 3.0 operation. 

 It is the spreads offered by your broker that chiefly determine how much profit you 

can make by using WallStreet Forex Robot 3.0. The recommended spread for 

EURUSD is under 2 pips, for GBPUSD under 3 pips, and for USDJPY under 2 pips. 

 Be on the lookout for brokers who steal pips and who try to fulfil each order at a 

price which is less favourable to you by 1 or 2 pips. This way, advertised 1 pip 

narrow spreads can easily work out at 3 or 5 pips, thus reducing profits made by 

WallStreet Forex Robot 3.0. Be particularly cautious of new brokers who advertise 

aggressively on the internet. 
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The MetaTrader4 (MT4) Trading Platform 

WallStreet Forex Robot 3.0 operates within the MetaTrader4 trading platform. MT4 is a 

free trading platform available through most forex brokers. 
 

 
 
We cannot stress enough, how important is to choose a decent, reputable 

FOREX broker with competitive spreads and good trading conditions. If you are 
new to FOREX trading, make sure that you spend enough time in your own 

research for that matter, before investing any real money in any FOREX broker! 
 

 

 

 

 

 

 

Installing MetaTrader 4 
 

Browse through this section if you are familiar with MT4 and already have a broker 
account. 

 
 

 
 

 

After completing installation, you will be asked to create a demo account. Fill in the 
details and select the amount of the account deposit. Enable Agree to subscribe to your 

newsletters, then click Next. 
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The program will ask you to select the trade server to which it should connect. Click 
Next. In the next window, click Finish. 
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Your demo account is opened. Close MT4 so that you can install WallStreet Forex Robot 

3.0. 
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INSTALLING WallStreet Forex Robot 3.0 

 

We offer you two ways of installing our software: 

Automatic installation using WallStreet Forex Robot 3.0 installer 

Automatic installation is very convenient because you only need to download a single 

file, start the installation process and follow the steps. Finally, the robot is automatically 

installed in your terminal. Please read the instructions below to install WallStreet Forex 

Robot 3.0 to your MT4/MT5 terminal: 

 After logging into the member area with the username and password provided, go to 

the download page. In download page, on the picture showed below, you have to 

click on “DOWNLOAD” button in order to download automatic installation file. We 

recommend you to save the file in convenient location on your computer. 

 

 

 Go to the folder where you saved the file and double click on the file to start the 

installation process. 

 During installation, select the installation folder of your MetaTrader 4 or MetaTrader 

5 terminal. This folder would usually have the name of your broker and would be 

found in C:\Program Files. 

 Follow all the steps until you finish the installation. 

 

NOTE: The installer also contains the MT5 version of WallStreet Forex Robot 3.0. If you 

want to use the robot on MT5 terminal you only need to select the installation folder of 

your MT5 terminal during the installation process. 
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Manual installation 

In addition to automatic installation, we also offer manual installation. For this purpose, 

we have created an archive that contains all the components and different versions of 

our robot. In this archive you will find the versions of WallStreet Forex Robot 3.0 for 

MT4, MT5 and cTrader terminals. Please read the instructions below to install manually 

WallStreet Forex Robot 3.0 to your MT4/MT5 or cTrader terminal: 

1. After logging into the member area with the username and password provided, go to 

the download page. In download page, on the picture showed below, you have to 

click on “MANUAL INSTALLATION” button in order to download all the necessary files 

for manual installation. 

 

2. We recommend you to save the file to a convenient location on your computer. Then, 

go to the folder where you saved the file and extract (unzip) the archive you 

downloaded. You will find these files in the archive: 

- WallStreetForexRobot_3.0_vX.X.ex4 (for MT4) 

- WallStreetForexRobot_3.0_vX.X.ex5 (for MT5) 

- WallStreetForexRobot_3.0_vX.X.algo (for cTrader) 

- WALLSTREET_DOMINATION.dll (for using only on MT4) 

- wsfr3.bmp (for using in MT4 and MT5) 

3. Identify your "Application Data" folder. 

First you need to locate your Application Data folder of the MT4/MT5. To do this, go to 

the File menu in the MT4/MT5 platform and click on "Open Data Folder" (check out the 

image below). 
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4. Place your robot files in the right location. 

First thing to do is to open the MQL4 (MQL5 for MT5) folder, which is in the "Application 

Data" folder (which you already see). The next steps are very easy: 

 Place the "WallStreetForexRobot_3.0_vX.X.ex4" file in the "Experts" folder 

inside the "MQL4" folder. If you use MT5 terminal, then place " 

WallStreetForexRobot_3.0_vX.X.ex5" in the "Experts" folder inside the 

"MQL5" folder. 

 Place the "WALLSTREET_DOMINATION.dll" file in the "Libraries" folder inside 

the "MQL4" folder. 

 Place the “wsfr3.bmp” file in the “Images” folder inside the "MQL4" (MQL5 for 

MT5 terminal). 
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5. Run the WallStreet Forex Robot 3.0. 

After you have successfully placed the files in the correct folder, all you need to do is to 

restart your MT4/MT5. If you have done everything correct, the EAs should appear in 

the "Navigator" Tab of your MT4/MT5. 

 

 
NOTE: You can find instructions for installing WallStreet Forex Robot 3.0 on cTrader 

platform on page 33. 
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ACTIVATING WallStreet Forex Robot 3.0 
 

 

You should activate your copy of WallStreet Forex Robot 3.0 for your demo and real 

accounts through our website. Login to our member zone and then find the account 
activation page. Type your account number into the input field, select the type of 
your account (demo or real), select WallStreet Forex Robot 3.0 from the list of 

available forex robots and click Activate button. Repeat this procedure for each 
account. 

 
Your WallStreet Forex Robot 3.0 licence is valid for an unlimited number of demo 
accounts and for one real money account. The licence is not tied to one computer. 

You are free to trade using your accounts on any computer at home, in the office, or 
VPS. 

 
As well, you have an option to remove an account that you do not use and activate a 
new account on its place. 

 
You should activate your demo or real account even if you wish to backtest 

WallStreet Forex Robot 3.0.  
 

Your online authentication procedure may take some time. If you see an 
“Online Authentication Problem!” alert, wait a couple of minutes and try 

again. If the problem persists, contact us at 

support@wallstreet-forex.com 

 

 

Here's how the activation form looks like: 

 

 
 

 

 

 

mailto:support@forex-combo.com
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You can see your currenly activated account numbers in the below table: 
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STARTING AND CONFIGURING 

WallStreet Forex Robot 3.0 

 

After installing and activating WallStreet Forex Robot 3.0, launch your MT4 terminal and 

click Tools->Options. 

 

At this stage, make certain that you have checked and unchecked all the boxes exactly 

as shown below in order to ensure correct WallStreet Forex Robot 3.0 operation. 
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Now, open the graphs for the currency pairs you wish to trade, then select the 15-

minute graph, М15. 

For a comprehensive information regarding the recommended, the supported currency pairs and 

for the alternative settings, please visit the “Settings” section in your members area. 

 

Select the 15-minute graph, М15. 

 

Now you are ready to place WallStreet Forex Robot 3.0 on the chart. In the Navigator 

window, double click Expert Advisors to expand it. You should now see all Expert 

Advisors including WallStreet Forex Robot 3.0. Now, you can right click WallStreet Forex 

Robot 3.0 and select Attach to a Chart, or alternatively simply drag WallStreet Forex 

Robot 3.0 onto the chart. 
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After placing WallStreet Forex Robot 3.0 on the chart, you should see a smiley face 
in the upper right hand corner of your chart. This means the robot is running. If you 

do not see a smiley face, make certain that under Properties on the menu bar, the Allow 
Live Trading box is checked. If it is checked and you still do not see a smiley face, go to 
Tools on the menu bar and select Options. A popup will appear. Select the Expert 

Advisors Tab and check both the Enable Expert Advisors box and the Allow Live Trading 
box.  

 
You can enable or disable WallStreet Forex Robot 3.0 from the Expert Advisor button at 
any time. 
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WallStreet Forex Robot 3.0 

 SETTINGS 
 

You can edit WallStreet Forex Robot 3.0 settings by right clicking anywhere on the chart 

and selecting Expert Advisors -> Properties. 

WallStreet Forex Robot 3.0 automatically updates its settings from our web 

server. This means that you can relax: your forex robot is always trimmed to 

prevailing market conditions. 

Magic: a unique identifier through which WallStreet Forex Robot 3.0 recognises and 

manages its own positions. If you use other expert advisors on the same account, 

please ensure that each of them has a distinct unique identifier. 

 

EA_Comment: you can type here a comment, if you wish to mark the WallStreet Forex 

Robot 3.0 trades. 

 

MaxSPREAD: maximum allowed spread. 

 

Slippage: maximum allowed slippage. 

 

StealthMode true/false: a mode which conceals stoploss and takeprofit levels in 

program logic, making them invisible to brokers. If you use this mode, the stoploss and 

takeprofit orders are not located in the trading server. In this case, if your trading 

terminal is not connected, or the robot is not working, your orders would not be 

protected. However, we are strongly encouraging using the StealthMode, 

because in some cases the visible StopLoss levels could be attacked 

tendentiously by algorithms that some unethical brokers could use.   

 

EmergencyStopDist: this parameter ensures a second level of protection, when 

StealthMode is used. At values greater than zero it activates a second level of true 

(Emergency) StopLoss on a greater distance then the virtual hidden StopLoss is located. 

In such case the value of the new emergency StopLoss will be the sum of the 

EmergencyStopDist value plus the value of the hidden StopLoss.  

 

As an example if StealthMode is used and the hidden “system” StopLoss is 60 pips and 

the EmergencyStopDist is 100 pips, then the emergency StopLoss will be placed 160 

pips away from the trade entry price. The only purpose of this is to protect you from 

some extremely rare circumstances in which the market moves excessively and the EA 

does not manage to close by a market order on the actual “hidden” StopLoss level.  
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CloseOnlyOnProfit true/false: when this mode is enabled, positions close to system 

signals only, when they are in profit, or where stoploss may be reached. If 

CloseOnlyOnProfit= false /default/, positions close to system logic even it is on a loss. 

 

NFA true/false: use "true" if your broker is NFA regulated. 

 

No_Hedge true/false: use "true" if you wish to cancel all hedge trades. 

 

WinLargeFonts true/false: use "true" to adjust the robot information box display in 

case you are using the Windows Large Fonts. 

 

RefreshDays: this value manages the real-time auto-update interval in days 

 

PendingOrderDist: this value manages the new Pending (Stop/Limit) Orders 

functionality: 

- If the value is zero (default) the robot will use only market orders. 

- If the value is greater than zero (a positive value) the robot will use “Limit” orders 

with a distance from the market price equal to the PendingOrderDist value in 

pips. 

- If the value is lower than zero (a negative value) the robot will use “Stop” orders 

with a distance from the market price equal to the PendingOrderDist value in 

pips. 

 

Generally, we recommend using market orders, but we’ve designed this functionality to provide 

an additional flexibility to those our users, which would be interested to experiment. As an 

example, if you notice that your broker executes the market orders with a great slippage, you can 

try using Limit, or Stop orders. The Limit orders would help to open the trade on a most 

favourable price, but you can miss some of the trades. We recommend this functionality only for 

advanced traders, which are capable to make their own backtests and optimisations. 

 

StopLimitExpire: this value (in minutes) manages the pending orders expiration in case 

you are using the Pending Orders functionality. 

 

StopLoss: distance to stoploss levels in standard (4 digits) pips. 

 

TakeProfit: distance to takeprofit levels in standard (4 digits) pips.  

 

SecureProfit: minimum profit to be guaranteed where the position’s current profit is 

equal to the value of the SecureProfitTrigger parameter.  

 

SecureProfitTrigger: the position’s current profit (in pips) which would guarantee 

minimum profits equal to value of the SecureProfit parameter. 

 

UseCustomPair true/false: if you wish to use WallStreet Forex Robot 3.0 on a 

unsupported currency pair, change UseCustomPair=true 
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UseSettingsFrom: if you wish to use WallStreet Forex Robot 3.0 on an unsupported 

currency pair, with this input parameter you can choose, which supported settings you 

wish to use. It is not necessary to change this parameter if you use some of the 

supported currency pairs. It is only in case you use "UseCustomPair=true". 

 

FixedLots: the extent of the fixed trading volume. If you use AutoMM>0, the value of 

the FixedLots parameter does not matter. 

    

AutoMM: automatic risk management activates at values greater than zero: 

- Example 1: at AutoMM = 2, WallStreet Forex Robot 3.0 opens positions equal to 0.2 

lots (20,000) given account extent of 10,000. This places 2 percent of the account 

extent at risk per individual transaction at a loss of 100 pips. 

- Example 2: at AutoMM = 10, WallStreet Forex Robot 3.0 opens positions equal to 1 lot 

(100,000) given account extent of 10,000. This places 10 percent of the account extent 

at risk per individual transaction at a loss of 100 pips. 

 

RecoveryMode true/false: when RecoveryMode is activated, an algorithm effectively 

compensates current drawdown through smooth increases of trading volumes. This 

mode is active only when AutoMM is greater than zero (AutoMM > 0). Before activating 

RecoveryMode, please bear in mind that it can significantly increase risk to your account. 

For this reason, RecoveryMode should be used at low values of the AutoMM parameter. 

 

AutoMM_Max: the maximum permitted risk expressed as a percentage of the account 

per individual transaction, calculated on the basis of a 100 pip loss. 

 

MaxAccountTrades: using this parameter you could limit the number of 

simultaneously opened trades in your account. The default value is zero, which means 
that by default this option is disabled. 

 
MaxAccountDD: the maximum allowed drawdown for the account in percent. The 

option activates at values greater than zero. This option is based on the current 
drawdown, which is the difference between the current account balance and equity. 
 

MondayStartHour: The robot will start trading after this hour on Monday. If you want 
to set any custom value it must be between 0 and 23. To completely disable trading on 

Monday set MondayStartHour=24. 
 

FridayExit true/false: if you wish to close all trades on Friday, you should use 
FridayExit=true 

 
LastTradeHour: the robot can trade until the end of this hour on Friday (including this 

hour). 
 
ExitHour: the robot will close all open positions at this hour on Friday. 

 
If you decide to use the "FridayExit" option you should set "LastTradeHour" and 

"ExitHour" several hours before the market closing of your broker on Friday. 
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Avoid_News true/false - if you wish to use the news filter function, you should set 

Avoid_News=true 

 

AutoGMT_Offset  true/false – this parameter controls the GMT Offset calculation 

method. In most of the cases, the automatic GMT value is correct. However, in some 

cases, you may need to enter the GMT Offset by yourself. In this case, switch 

AutoGMT_Offset to false and enter the value you need in the ManualGMT_Offset 

parameter. 

 

ManualGMT_Offset – in case you switch to AutoGMT_Offset=false, the value of this 

parameter should be the right GMT Offset of your broker (usually, the winter GMT 

offset). As well, in case you perform a backtest, you should enter here the correct GMT 

Offset for the historical data you use – otherwise, the backtest will be incorrect. 

 

DST_Usage true/false – activates the automatic DST (Daylight Saving Time) 

correction. 

 

Include_Medium_News true/false:  if you also wish to avoid the medium impact 

news, you should set Include_Medium_News=true 

 

Wait_Before_News: the number of minutes before the news event, during which 

trading will be switched off 

 

Wait_After_News: the number of minutes after the news event, during which trading 

will be switched off 

 

NEW UseMarketBiasFilter true/false – activates/deactivates our new Market Bias 

filter algorithm, which is an additional filter for filtering all long, or short trades. If you 

activate it, you can expect more precise trend filtering, but the overall number of trades 

taken by the robot may be reduced. Our tests are positive, but the reduction of the 

trading frequency is something that many traders do not like. Because of this, using this 

additional filter is a matter of your personal choice as a trader. 

 

NEW ThresholdPercent: additional threshold level in percent. The MarketBiasFilter 

represents the volume of the long and short positions on the market in percent, so you 

can use an additional threshold percent filtering: as example if you enter value of 60%, 

this means the filter will cancel all long trades taken by the robot, unless the market is 

more than 60% long and all short trades, unless the market is more than 60% short. 

 

Important: StopLoss and TakeProfit have default values of zero (0). When the default 

value is selected, WallStreet Forex Robot 3.0 uses StopLoss and TakeProfit values 

broadcast by our web server. If you wish to set your own StopLoss and TakeProfit values, 

simply input values different to zero. In such a case, WallStreet Forex Robot 3.0 shall 

use the StopLoss and TakeProfit values set by you.  
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StopLoss values broadcast from our web server are usually in the range of between 100 

and 200 pips. A reasonably broad StopLoss offers the WallStreet Forex Robot 3.0 system 

logic the opportunity of closing positions at optimum price levels, even when a loss may 

be made. Using a close StopLoss of the order of 30 to 60 pips would also be reasonable 

in some situations. In the general run of cases, this would reduce system drawdown, but 

would also reduce profits. In support of this, we would offer the following examples in 

the EURUSD currency pair at different StopLoss values: 

 

Simulation period 5 years: 

 

When not using StopLoss, or where StopLoss is set at 300 or more pips, the results 

would be: 

- Total net profit = 5590 pips 

- Profit factor = 2.96  

- Maximum drawdown = 320 pips  

 

 

When setting StopLoss at 130 pips, the results would be: 

- Total net profit = 5172 pips 

- Profit factor = 2.54  

- Maximum drawdown = 225 pips  

 

When setting StopLoss at 30 pips, the results would be: 

- Total net profit = 3947 pips 

- Profit factor = 1.88  

- Maximum drawdown = 203 pips 
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WallStreet Forex Robot 3.0  

BROKER SPY MODULE 
An insider look to the Broker behavior 

 

 
The BROKER SPY MODULE compares the initial entry/exit price ordered from the robot, 

with the actual broker execution price. The difference between the ordered price and 

the broker execution price is the actual slippage.  

If the broker is a correct one (and you are not trading news, spikes or other extreme scalping 

techniques) the slippage could be either positive, or negative. In long term the average 

slippage should be close to zero.  

Unfortunately some brokers are literally stealing from their clients with tendentious 

negative slippage without any objective market reason. This is why we’ve developed the 

BROKER SPY MODULE – to provide to our users this extremely important information - 

an inside look to the broker’s behavior.  
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The BROKER SPY MODULE aggregates the whole important information of all trades 

executed from the robot since it is started. All statistics is written on an external file, so 

even if you restart the robot multiple times the statistics will not be lost.  

If you change the magic number of the robot, the robot will create a new file and 

the statistic will start from that moment. All statistics files from different magic number 

initializations will be kept with the used magic number in the name of the file. If you 

want to continue the statistics on some particular file you just need to initialize the 

robot with the same magic number as is in the file name. The BROKER SPY MODULE 

statistics files are located in the MT4 Data Folder->MQL 4->Files.  

The BROKER SPY MODULE also provides important information about the average order 

execution delay. The order execution delay could be initiated from the broker in low 

liquidity conditions, or other objective reasons. Unfortunately in some cases some 

brokers could use this tendentiously to steal their clients. In other cases the orders 

delay could be caused by poor, or busy internet connection. However in all possible 

scenarios this is a very important information to know. It could be considered as normal 

if your order delay is below 1000 ms (1s) in normal market conditions, unless you do 

not get a tendentiously negative slippage. 

In addition the BROKER SPY MODULE provides statistics for the average spread for all 

moments in which the robot initiate a trade signal. 

 

Here is what exactly the BROKER SPY MODULE (BSM) statistics show: 

The values in the brackets represent the extracted from the BSM history file data, from 

all previews initializations of the robot. The values outside the brackets represent the 

statistics since the last initialization of the robot. 

First Trade – the date and time of the first trade from the statistics. 

Last Trade – the date and time of the last trade from the statistics. 

Total Errors – the total number of recorded errors for all type of orders 

Stop/Limit Orders - the total number of successfully placed pending orders 

Stop/Limit Deals - the total number of successfully activated pending orders 

Market Trades - the total number of successfully executed market orders 

Total Entry Slippage – the total slippage from all market and all activated pending 

orders in standard 4 digit pips. 

Average Slippage – the average slippage from all market and all activated pending 

orders in standard 4 digit pips. 
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Average Speed – the average time delay for accepting of all type of orders in 

milliseconds (ms) 

Exit Signal Trades – the total number of successfully executed exit market orders 

Total Exit Slippage - the total slippage from all exit market orders in standard 4 digit 

pips. 

Average Slippage – the average slippage from all exit market orders in standard 4 

digit pips. 

Average Speed - the average time delay for accepting of all exit market orders in 

milliseconds (ms) 

Average Spread – average spread for all trading signals generated from the robot in 

standard 4 digit pips. 

Last Signal Spread – the spread for the last trading signal generated from the robot 

High Spread Count – the total number of cases in which the trade is canceled due to 

high spread, considering the MaxSPREAD setting. 

Another great future that the BROKER SPY MODULE provides is that you can use it as a 

test tool to check the behavior of your broker. For this purpose we’ve developed special 

“high frequency” trading settings. The only thing you need to do is to start WallStreet 

Forex Robot 3.0 with the minimum possible lot size and changing UseCustomPair 

to “true” and UseSettingsFrom to GBPFST (capital letters). This way the robot will 

execute about 100 trades a day. The average profit expectancy of these settings is 

minus one spread, so if you let the EA trade for one day (24 hours) the expected loss 

will be about $15-25, but you will have an invaluable information about your broker 

behaviour. 20-30 trades are enough to get the information you need, so we recommend 

using this future for several hours, under your supervision.  

PLEASE, USE THIS FUTURE WITH CAUTION, DEFINING THE MINUMUM LOT SIZE 

AND BEING FULLY AWARE OF YOUR ACTIONS!!! 
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BROKER SPY MODULE 

 SETTINGS 

 
BSM_Alerts true/false: use True, if you want to activate the Broker Spy Module alerts.      

BSM_Alert_Open_Delay: the maximum allowed delay in milliseconds (ms) for 

opening new trades, above which the BSM will display an alert.               

BSM_Alert_Open_Slippage: the maximum allowed slippage (in standard 4 digit pips) 

for opening new trades, above which the BSM will display an alert.                   

BSM_Alert_StopLimit_Delay:  the maximum allowed delay in milliseconds (ms) for 

accepting pending (Stop/Limit) orders, above which the BSM will display an alert.              

BSM_Alert_StopLimit_Slippage: the maximum allowed slippage (in standard 4 digit 

pips) for activating pending (Stop/Limit) orders, above which the BSM will display an 

alert.   

BSM_Alert_Close_Delay:  the maximum allowed delay in milliseconds (ms) for closing 

trades, above which the BSM will display an alert.             

BSM_Alert_Close_Slippage: the maximum allowed slippage (in standard 4 digit pips) 

for closing trades, above which the BSM will display an alert.                   
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Advanced Time Management System 

SETTINGS 

These settings have been specially developed to help traders avoid certain hour periods 

during the trading week when the Forex market behaves more unpredictable.  

 

MondayTrading true/false – enables trading on Monday. 

MondayHoursForbidden – sets forbidden trading hours for Monday (applies only when 

MondayTrading is enabled). You can set several values between 0 and 23 separated with 

commas. For example, if you set MondayHoursForbidden=9,10,11 the EA will not trade 

from 9:00 till 11:59. The hour values for this parameter are related to your broker’s 

server time (the Market Watch)! 

TuesdayTrading true/false – enables trading on Tuesday. 

TuesdayHoursForbidden – same as MondayHoursForbidden with the difference that 

you set forbidden hours for Tuesday. 

WednesdayTrading true/false – enables trading on Wednesday. 

WednesdayHoursForbidden – same as MondayHoursForbidden with the difference 

that you set forbidden hours for Wednesday. 

ThursdayTrading true/false – enables trading on Thursday. 

ThursdayHoursForbidden – same as MondayHoursForbidden with the difference that 

you set forbidden hours for Thursday. 

FridayTrading true/false – enables trading on Friday. 

FridayHoursForbidden – same as MondayHoursForbidden with the difference that you 

set forbidden hours for Friday. 

SaturdayTrading and SundayTrading true/false – enables trading during Saturday 

and Sunday respectively. Due to big GMT offset, some brokers trade during weekends 

and for that reason we added these parameters as well. 
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  RISK MANAGEMENT HINTS 

 

Risk management is of fundamental importance in attaining optimum forex trading 

results. It pays to think carefully before deciding what percentage of your account to 

expose to risk in each individual transaction. 

If your account is significant in extent and importance and if you do not wish to take 

unnecessary risk, then you should settle for AutoMM values between 1 and 5 percent 

risk per individual transaction. In such case, you may expect a return on investment in 

the order of 10 to 100 percent on an annual basis. 

If your account is not significant in extent or importance, and if you can afford to 

assume significant risk, then you may select AutoMM values between 10 and 20 

percent per individual transaction. In such case, you may expect a return on investment 

in the order of 200 and 1000 percent on an annual basis. Bear in mind, however, that 

the level of risk assumed means that the chance of losing the entire account increases.  

In reality, perhaps the most widely assumed risk per individual transaction is 5 percent 

(AutoMM=5), and for a good reason. Assuming 5 percent risk and applying a good 

trading strategy, your chances of steady long-term profit are significant, while the risk of 

losing the entire account is minimised.  

For example, if you have a USD 10,000 account, then: 

 
- If AutoMM=0, the EA will trade with volume = parameter FixedLots (defaults        
FixedLots=0.1) 

- If AutoMM=2 (2 percent risk) the EA will open 0.2 lot positions (20,000) 
- If AutoMM=5 (5 percent risk) the EA will open 0.5 lot positions (50,000) 

- If AutoMM=10 (10 percent risk) the EA will open 1.0 lot positions (100,000) 
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HOW TO BACKTEST 
WallStreet Forex Robot 3.0 

 

Please, do not forget to activate your demo, or real account, even if you only 

wish to backtest WallStreet Forex Robot 3.0!  

Please use the backtest version of the robot – it is much lighter and faster! 

If you wish to back-test WallStreet Forex Robot 3.0, first you should download history 

from the MetaTrader history center: click Tools -> History Center, or press the "F2" key 

of the keyboard.  In the list, find the currency pair that you wish to back-test and 

double click to expand it. Click "1 Minute (M1)" and then click "Download". When the 

download process is finished, double click on "5 Minutes (M5)” and "15 Minutes (M15)" 

to convert the M1 data. Close the "History Center" window. 

 

 

 

To open the "Strategy Tester" window click the "Strategy Tester" button of the 

MetaTrader menu, or press "Ctrl+R" on the keyboard. In the "Strategy Tester" window 

chose "WallStreet Forex Robot 3.0 ", chose one of the supported currency pairs, chose 
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M15 timeframe, chose the method "Every tick ...", as shown below. Click "Start" to start 

the back-test.  

 

 

The back-test by "Every tick" is the most precise, but it is very slow. If you wish to save 

time you can run the back-test on M1 timeframe by "Open price only ..." method and 

this will be correct too.  

Important notice: If you make a back-test and at the same time you have WallStreet 

Forex Robot 3.0 attached on the chart in live trading mode, this can overload your 

MetaTrader4 terminal and can be a cause for a MataTrader 4 terminal crash. Do not 

make back-tests on the same MataTrader 4 terminal, which you use for live trading! 

 

 

We strongly recommend that you operate a demo account before trading with 

real money. This will help you become familiar with the way WallStreet Forex 

Robot 3.0 operates before you commit genuine funds to a real money account. 
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EMAIL AND MOBILE PUSH 

NOTIFICATIONS 

 

 

 

WallStreet 3.0 Domination comes with EMAIL and Mobile PUSH 

Notification system 

 

WallStreet Forex Robot 3.0 gives traders a bit of freedom with the new notification 

system. Traders don’t have to sit in front of their computer all day monitoring their 

traders. In spite of this freedom, traders like to know when a trading position has been 

opened or closed out. Now WallStreet Forex Robot 3.0 will inform you about all actions 

performed in your account. It easy to set-up your terminal to receive these notifications. 

The robots can send email and push notifications to your mobile phone and inform you 

about all the trades. By default, these options are disabled. In order to enable these 

options, you have to set:  

 

 EMAIL_Notification=true 

 PUSH_Notification=true 

 

To receive email messages, you have to configure the MT4 terminal properly too. 

The configuration must be done in: 

MT4 Menu -> Tools -> Options -> Email   

Please check the next image: 
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To receive Mobile Push notifications, you have to enable Push Notifications and to 

enter your mobile terminal MetaQuotes ID here: 

MT4 Menu -> Tools -> Options -> Notifications 
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WallStreet Forex Robot 3.0  

for cTrader platform 

 

 

 

WallStreet Forex Robot 3.0 is also compatible with cTrader trading platform. cTrader 
platform is also very popular and most of the brokerage companies offer such trading 

platform. Forex robots for cTrader platform are called cBots. The filename extension for 
cBots is .algo.  

 
You can find the cTrader version in the archive for manual installation. Please check the 
page 10 from the user guide for more information. The name of the .algo file is in this 

format: WallStreetForexRobot_3.0_vX.X.algo. You can download the archive and 
extract its content. Find the .algo file and use it on cTrader. Continue reading below to 

find how to install WallStreet Forex Robot 3.0 on your cTrader platform: 
 

1. First way: The easiest method to install an algo file is to simply double-click your 

mouse on the file you want to install, what will happen next is that cTrader will 
start to open, if it is not already open, wait for this to complete. If you get any 

popups asking confirmation just confirm and continue. The algo file will be 
installed automatically. 

 

 
2. Second way: If 1st way does not work, this would be because your operating 

system does not recognize algo files, you will need to open your documents folder 

using windows explorer and navigate to the Sources folder, here you will see two 
other folders, all you need to do now is open the relevant folder and copy/paste 

the algo file into this folder, this will automatically install or replace an existing 
file. 

 
 

Forex robots must be placed on folder Robots. Indicators on folder Indicators. 
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All Forex Robots of FXautomater 
 

All of our forex robots are listed below. You can find many paid or free forex robots. All these 

forex robots are developed by FXautomater. We develop different kind of expert advisors - fully 

automated, hybrid systems, grid strategies, martingale strategies, scalpers, trending forex 

robots and etc.. We have at least one forex robot which may suits your needs. If you cannot find 

what you are looking for contact us and we may help you. 

 

 
 

 

Visit https://www.fxautomater.com to check all our forex robots! 

https://www.fxautomater.com/
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Terms of Use and Risk Disclosure 

 

U.S. GOVERNMENT REQUIRED DISCLAIMER 

FOREX trading has large potential rewards, but also large potential risk. You must be aware of 

the risks and be willing to accept them in order to invest in the FOREX markets. Don’t trade with 

money you can’t afford to lose. This is neither a solicitation nor an offer to Buy/Sell currencies, 

futures or options. No representation is being made that any account will or is likely to achieve 

profits or losses similar to those discussed on this web site. 

The past performance of any trading system or methodology is not necessarily indicative of 

future results. 

Trading foreign exchange on margin carries a high level of risk and is not suitable for all 

investors. The high degree of leverage can work against you. As with all investments, you should 

not invest money that you cannot afford to lose. Before deciding to invest in foreign exchange, 

you must carefully consider your investment objectives, level of experience, and risk appetite. 

Additionally, you must be aware of all the risks associated with foreign exchange trading and 

seek advice from an independent financial advisor. Past results are not necessarily indicative of 

future success. 

 

CFTC RULE 4.41 – HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN 

LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT 

REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES HAVE NOT BEEN EXECUTED, THE 

RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN 

MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN 

GENERAL ARE ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF 

HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO 

ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN. 

 

By using WallStreet Forex Robot 3.0, you acknowledge that you are familiar with these risks 

and that you are solely responsible for the outcomes of your decisions. We accept no liability 

whatsoever for any direct or consequential loss arising from the use of this product. It's to be 

noted carefully in this respect, that past results are not necessarily indicative of future 

performance. 

 

Your purchase WallStreet Forex Robot 3.0 serves as your acknowledgement and 

representation that you have read and understand these TERMS OF USE and that you agree to 

be bound by such TERMS OF USE ("License Agreement"). 

Copyright Information 

 

REPRODUCTION AND OR TRANSLATION OF ANY PART OF THIS WORK BY ANY MEANS 

ELECTRONIC OR MECHANICAL INCLUDING PHOTOCOPYING BEYOND THAT PERMITTED BY 

COPYRIGHT LAW WITHOUT THE PRIOR WRITTEN PERMISSION OF THE PUBLISHER IS 

UNLAWFUL. 

 

Copyright © 2021 – WallStreet Forex Robot 3.0, www.wallstreet-forex.com - All Rights Reserved 
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